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The search area of the UI window, in the upper left corner 
lets you search for people or forms to work with. You can 
click the icon on the left of the search field to switch 
between the person search and the form search.  

Search Area



When the search field is set to the person search you can search using a 
student ID or name. You can also do an advanced person search by 
clicking on the magnifying glass to the right of the search field. The 
advanced person search will allow you search for a person or 
organization using multiple search parameters. 

Person Search



To search for a from, type the mnemonic or words from the title of the form 
in the search box. When you enter in the mnemonic for a form it will open 
immediately. If you can not remember the mnemonic, but know one or two 
words from the form you can enter it and it will bring up a Search Results 
panel that displays all possible matching forms. *You can still use the mnemonic tree for access.

Form Search



Search 
Results Tab

•The search results tab stores your searches from the person and form searches.

Tabs



Navigation 
Tab

•Click the Navigation tab to access a Colleague form by navigating through the 
Colleague menu structure. Here is where you will find the familiar mnemonic tree 
menu. *Note – you no longer need to switch between modules you now have access to 
any form you have permissions for without switching between modules. 

Tabs



Favorites 
Tab

•You can save people or forms to your favorites tab and access them by click on 
the tab. To add a favorite click on the Gold star button in the context area (for 
person related records), the UI Form Area (for forms), or while in the Favorites 
panel.

Tabs



The File menu provides access to the following features (many of these 
are also available using keyboard shortcuts):
• Save – Save data on the current form
• Save All – saves data on all open forms
• Finish – Saves data on all open forms and closes all open forms
• Cancel - Cancels changes on the current form
• Cancel All – Cancels changes on all open forms
• Detail – Accesses the detail form, or a menu of available forms, from the current 

field.
• Add Active Form to Favorites – Adds the current form to Favorites
• Print Form – Prints the current form 
• Logout – Exits UI

File Menu

Menus
With UI, menu items are available on the left side of the tool bar (which is just 
above the form area). These menus proved access to many of the UI controls and 
features.



The Options menu provides access to the following features. Many of these 
features are also available using keyboard shortcuts:
• Preferences – Accesses the Preference dialog box, where you can change 

preferences such as the color theme and other user settings
• Clear Search History – Accesses the Clear History dialog box, where you can clear 

search history, contexts, and form scale values.
• Set Form Scale Default – Sets the global default scale factor for all forms to the 

current scale factor (set using the slider bar at the top of the UI form area). Forms 
with individual scale factor overrides are not affected by this global default.

• Clear All Form Scale Values – Clears all individual form scale factors and the global 
default scale factor. Without these scale values, forms are rendered using a “best 
fit” algorithm based on the size of the UI window. 

The Help Menu provides access to process the field help for the current 
Colleague form. It also provides access a list of all keyboard shortcuts and a 
help about message that provides information such as the current UI version 
number. 

Options Menus

Help Menu



The context area displays information about the current person-related 
record that you are working with. It can hold  person cards, organization 
cards or both. 

Context Area

It is important to remember that if you close out of a form 
you are not always closing out of the person or organization 
listed in the context area. You can set your context area to 
Auto-Close Context so that it will close out the record in the 
context area as you leave each form or you can set it to Keep 
Context Open which will leave the record available and 
default in on your next form. 
Auto-close Context is recommended to assist in limiting 
errors.



When multiple cards are loaded into the Context area you can use the Next 
and Previous buttons to scroll through the cards.  You can also select View All 
to see all cards currently in context. 



When Colleague displays a form, it resizes to minimize scrolling. You can use 
the scale slider to resize the current form and make the information larger or 
smaller as needed. 

Window Resizing and Form Scaling



Resolution Screens

Grid View Button

Export to Excel Button

Collapse Button

Select All Check Box
Card View Button

Open Button
Input Field



Grid View
Results are displayed in spreadsheet 
format, with the results in rows and 
columns.
You can sort the results by column and 
rearrange the columns. 

Card View
Allows for photos (people search) in addition 
to other information about the records.

Views



In both views you can hover over the Input field to view a tooltip 
that will show the options that can be used in this field.

Input Field



Web UI offers the option of exporting the search results to Microsoft Excel. 
Click the Excel icon. All search results records are exported to a spreadsheet.

Exporting Search Results



Report Printing

Report Page Navigation
This area shows you how many pages are within the 
report and allows you to click through to the next page, 
first page or last page.

Export PDF
Exports the report as a PDF file. When you select this 
option Export PDF dialogue box is displayed and various 
formatting options for PDF file. The formatting options are 
not saved for future UI sessions. 

Save As 
Saves a copy of the report to your network 
or local hard drive. You will be asked to 
name the file and path. 

Print Remote
Allows you to print to a network printer without 
downloading to your computer.



Within a form a multi-value field you will now see a Table Controller 
appear when you click on those fields. This tool will make moving 
through the list of items easier. Scroll buttons allow you to move from 
record to record or directly to last or back to first. You can view the 
pages/fields in the list and you can export the items to excel. 

Click and hold 
on “page” to 

slide the 
controller 

across the fields 
for better 
viewing.

Excel Export 

Scroll Buttons

Table Controller



User Preferences

You can set your personal preferences for UI on the Preferences dialog box. Changes to 
these preferences apply to your user profile only.

To access the Preferences dialog box, click on Options  Preferences from the menu bar.

Click on the Layout & Colors section 
to change:
• Color Theme: Various color 

themes are available for selection.
• Form Background Color: Select 

one of the available background 
colors for UI forms



Example Scenario LookUp Prompt Entry Hints
The last record that you displayed 
during this login session.

The ‘at’ sign (@) The “at” sign allows you to retrieve the 
last form-appropriate record that you 
displayed in most, but not all, cases. 

A list of all records appropriate for 
this form.

An ellipsis (…) Due to the size of the Person and 
Organization LookUp, the ellipsis is not 
supported for these files.

A list of fields in the file that 
contains the records that you are 
seeking.

A semicolon (;) You can use the field names to construct a 
query statement to look for a record.

All records in which a specific field 
contains a value (that is, the field is 
not blank).

;fieldname
For example, on the Approvals Needed 
(APRN) form in the Colleague Finance 
Accounts Payable Module, to see a list of 
approval records for individuals who are 
limited in the purchase order amount they 
may approve, enter the following:
;apprv.po.max.amt

Standard LookUp Shortcuts



Example Scenario LookUp Prompt Entry Hints
All records in which a specific field’s 
value matches a particular string.

; fieldname string
For example, on the APRN form in the 
Colleague Finance Accounts Payable 
module, to see a list of approval records 
for individuals who can approve up to 
$10,000 on a purchase order, enter the 
following:
; apprv.po.max.amt
10000

With the exception of a person’s name, 
multiword values must be enclosed within 
double quotes.
You can also look for multiple values at 
one time. For example, to see a list of 
approval records for individuals who can 
approve up to $10,000 or up to $15,000 on 
a purchase order, enter the following:
; apprv.po.max.amt
10000 15000

All records in which a specific field’s 
value begins with a particular string.

; field string…
For example, on the Job Skill Definition 
(JSKL) form in the Colleague HR 
Personnel module, to see a list of all job 
skill definitions whose descriptions 
begin with the word “Typing” or “Type”, 
enter the following:
; jsk.desc Typ…

Use this option when you are not sure how 
the item you are looking for is spelled or 
worded but you know how it starts.
Remember that text values, such as “Typ,” 
are often case-sensitive.

All records in which a specific field’s 
value ends with a particular string.

; fieldname …string
For example, on the JSKL form in the 
Colleague HR Personnel module, to see 
a list of all job skill definitions whose 
descriptions end with the word “Wpm,” 
enter the following:
; jsk.desc …Wpm

Use this option when you are not sure how 
the item you are looking for is spelled or 
worded but you are fairly certain about 
how it ends.
Remember that text value such as “Wpm,” 
are often case-sensitive.

Standard LookUp Shortcuts cont’d



Custom Lookup Shortcuts

Several look ups shortcuts have been created to aide in the process.
When searching on a particular form with these shortcuts simply enter a 
semi colon ; then the short cut then the data. 
Example: A short cut on the person file is birthdate. The short cut is BD. 
The look up would be:
;BD 01/05/77

You can also join short cuts in the lookup to search for multiple values.
Example: A birthdate of 01/01/77 and lives in the city of Orange
The lookup would be:
;BD 01/01/77 ;C Orange



Custom Lookup Shortcuts

File Description Shortcut
ACAD.PROGRAMS Start Date

End Date
Degree
Locations

SD
ED
DG
LO

ADDRESS Zip Code
City
State
Country
County

X2
X3
X4
X5
X6

CORP Source
Class
Soundex
Partial Name
Address
City 
State
Zip
Country

S
Y
LN
PN
A
C
ST
Z
F

CORPFOUNDS Source
Class
Soundex
Partial Name
Address
City 
State
Zip
Country

S
Y
LN
PN
A
C
ST
Z
F



File Description Shortcut
COURSE.SECTIONS Locations

Term
Subject
Course Number
Select Start Date
Select End Date
Synonym
Academic Level
Building
Faculty
GL Number

LO
TM
SU
SC
ST
EN
S
AL
BG
FA
GL

COURSES Locations
Subject
Terms Offered
Course Start Date
Course End Date

LO
SU
TR
ST
EN

ORG.PERSON Sources
Class
Address
City
State
Zip
Country
SSN
Status
Alien ID
Alternate ID

S
Y
A
C
ST
Z
F
SS
PS
AL
AID

Custom Lookup Shortcuts



File Description Shortcut
PERSON Source

Class
Address
City
State
Zip
Country
SSN
Status
Alien ID
Alternate ID
Birth Date

S
Y
A
C
ST
Z
F
SSN
PS
AL
ALT
BD

STAFF Source
Class
Address
State
Zip
Country
SSN
Status
Alien ID
Alternate ID

S
Y
A
C
ST
Z
F
SS
PS
AL
AID

Custom Lookup Shortcuts



Keyboard Shortcuts

• Change focus to search box (toggles between Person and Form search): Ctrl+Shift+S 
• Show Search Results panel: Ctrl+Alt+R 
• Show Clear History dialog box: Ctrl+Alt+T 
• Show Advanced Person Search dialog box: Ctrl+Alt+A 
• Show Navigation Panel: Ctrl+Alt+N 
• Show Favorites Panel: Ctrl+Alt+F 
• Exit/Logout: Ctrl+Alt+L 
• Show Help (for current UI area in focus): Ctrl+Alt+H 
• Show Keyboard Shortcuts: Ctrl+Alt+K 
• View all records in Context Area (card selector drop-down): Ctrl+Shift+A 
• Close current record in Context Area: Ctrl+Shift+X 
• Close all records in Context Area: Ctrl+Alt+X 
• Add current record in Context Area to Favorites: Ctrl+Shift+V 
• Add all records in Context Area to Favorites: Ctrl+Alt+V 
• Go to next record in Context Area: Ctrl+Shift+N 
• Go to previous record in Context Area: Ctrl+Shift+R 
• Close open panels (and return to the main UI window): Esc 
Note: Some of these shortcuts may not work in all browsers. Browser plug-ins or other applications may override 
these shortcuts and activate different commands.

These short cuts are available when your curser is not within a UI form.

Non-form shortcuts



Keyboard Shortcuts

• Move to the next field: Tab 
• Move to the previous field: Shift+Tab 
• Open a drop-down list to select a value: Down Arrow 
• Scroll through the values in a drop-down list: Up/Down Arrow 
• Select the highlighted value in the drop-down list: Enter
• Move forward one row in a table: Down Arrow *
• Move back one row in a table: Up Arrow *
• Move forward one page in a table: Page Up 
• Move backward one page in a table: Page Down 
• Move to the previous form: Ctrl+Page Up (Windows) | Command+Page Up (Mac)
• Move to the next form: Ctrl+Page Down (Windows) | Command+Page Down 

(Mac)
• Move to the beginning of the current field: Home 
• Move to the end of the current field: End 
• Move to the first row of a table: Ctrl+Home 
• Move to the last row of a table: Ctrl+End 

These keyboard shortcuts are available only when working within a UI form(alternative 
keystroke combinations are separated by |). Most of these commands are also accessible 

with the mouse from the UI form menu.

Form shortcuts



Keyboard Shortcuts
Form shortcuts

• Field insert in a table: Insert
• Field delete in a table: Ctrl+Alt+D 
• Cancel from current form: F8 
• Cancel from all forms: Shift+F8 
• Finish from current form: Ctrl+F9 (Windows) | Ctrl+9 (Mac)
• Save current form: F9 | Ctrl+0 (zero, not the letter o) 
• Save all open forms: Shift+F9 (Windows) | Ctrl+8 (Mac)
• Detail: F2 
• Print active form: Ctrl+Alt+P 
• Help: Ctrl+Alt+H | F1 (shows help for area currently in focus; F1 may not work in all 

instances) 
• Change focus to UI Form Menu Bar (then use tab and arrow keys to access menu 

items): Ctrl+U
• Show Keyboard Shortcuts: Ctrl+Alt+K 
• Read all Inquiry fields on a form (with screen reader software): Ctrl+Alt+I 
*If the current field within a table has a drop-down list, use Down Arrow to open the list, Up/Down Arrow to 
move up and down within the list, and Ctrl+Up or Ctrl+Down to move back or forward one row.




	Slide Number 1
	Slide Number 2
	Slide Number 3
	Slide Number 4
	Slide Number 5
	Slide Number 6
	Slide Number 7
	Slide Number 8
	Slide Number 9
	Slide Number 10
	Slide Number 11
	Slide Number 12
	Slide Number 13
	Slide Number 14
	Slide Number 15
	Slide Number 16
	Slide Number 17
	Slide Number 18
	Slide Number 19
	Slide Number 20
	Slide Number 21
	Slide Number 22
	Slide Number 23
	Slide Number 24
	Slide Number 25
	Slide Number 26
	Slide Number 27
	Slide Number 28
	Slide Number 29
	Slide Number 30

